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1 Introducción 

 

El presente documento describe cuales son las tareas que se pueden ejecutar en la explotación de la 
herramienta FxCop v1.35 . 

 

2 Conceptos básicos 

 

FxCop es una herramienta que permite analizar el estilo, el diseño de código de ensamblados .Net y 
comprobar, por ejemplo, fallos en la seguridad del código, mejoras para el rendimiento, nomenclatura de 
elementos y su localización... 

Básicamente, la función principal de este software es comprobar que el código desarrollado cumple las 
guías de diseño de Microsoft: 

(http://msdn.microsoft.com/library/default.asp?url=/library/en-
us/cpgenref/html/cpconnetframeworkdesignguidelines.asp) 

Esta versión de FxCop se utiliza con .Net framework 2.0 y como mínimo funciona con ensamblados 
codificados en C#, J#, VB.NET y C++.NET. Posiblemente funcione con otros lenguajes. 

 

3 Funciones elementales 

 

3.1 Inicio de la aplicación 

 

Se accederá al menú Inicio, Programas, Microsoft FxCop 1.35, Microsoft FxCop 1.35, o bíen sobre el 
acceso directo existente en el escritorio para ejecutar el aplicativo. 

 

3.2 Funcionamiento de Microsoft FxCop 1.35 

 

FxCop analiza elementos de programación en los ensamblados, llamados objetivos (targets), y genera un 
informe que contiene mensajes sobre estos objetivos, incluyendo sugerencias de cómo mejorar el código fuente 
usado para generarlos. FxCop representa como reglas (rules) las validaciones que lleva a cabo durante un 
análisis. Una regla es un trozo de código que puede analizar objetivos y devolver un mensaje con los resultados 
encontrados. Los mensajes de las reglas identifican cualquier aspecto relevante de programación y diseño y, 
cuando es posible, provee información sobre cómo fijar el objetivo. 

Usando FxCop, se puede: 

• Controlar qué reglas son aplicadas a los objetivos. 

• Excluir un mensaje de una regla de proyectos futuros. 

• Aplicar hojas de estilo a los informes de la aplicación. 

• Filtrar y salvar mensajes. 

• Salvar y rehusar las configuraciones de una aplicación en futuros proyectos de FxCop. 
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Antes de analizar el código y los estilos del proyecto seleccionado, debemos tener en cuenta que para 
generar dicho análisis únicamente se pueden seleccionar librerías (*.dll) o ejecutables (*.exe), creados mediante 
los lenguajes mencionados en el punto anterior. Cualquier otro tipo de aplicación no podrá ser analizada por 
FxCop. 

Si ejecutamos la aplicación, se mostrará una ventana con los objetivos y reglas incluidos en el proyecto, 
así como los mensajes generados cuando se lleva a cabo un análisis. De esta forma, la ventana se divide en 
tres áreas principales: el panel de configuración a la izquierda, el panel de mensajes a la derecha y el panel de 
propiedades en la parte de abajo. 

 

 

 

 

El panel de configuración  muestra los objetivos y las reglas para el proyecto actual, en modo de vista de 
árbol. 

El panel de mensajes  muestra un informe, personalizable por columna, con aquellos mensajes 
generados de un análisis. Se pueden filtrar los mensajes mostrados seleccionando objetivos y reglas específicas 
en el panel de configuración. 

El panel de propiedades  contiene dos pestañas. La pestaña de resultado (Output), muestra mensajes de 
información, aviso y error cuando el traceo general (System.Diagnostics.TraceSwitch) está habilitado en el 
archivo de configuración FxCop.exe.config (habilitado por defecto). Cuando se muestra un mensaje en la 
pestaña de Resultado, podemos hacer clic con el botón derecho del ratón en el panel para mostrar un menú con 
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las siguientes opciones: 

• Clear: Borra toda la información del panel de Resultado. 

• Copy Selected: Copia al portapapeles la información seleccionada del panel de Resultado. 

• Copy all: Copia al portapapeles toda la información del panel de Resultado. 

La pestaña de propiedades (properties) muestra información detallada del objetivo regla o mensaje 
cuando se selecciona un objeto en el panel de configuración o de mensajes. 

3.2.1. Carga y análisis de un proyecto.  

Para analizar los ensamblados, la aplicación requiere la siguiente información: 

• Uno o más ensamblados para analizar. 

• Una o más reglas. FxCop habilita un conjunto de reglas por defecto en los proyectos nuevos. 

Para comenzar el análisis del proyecto, presionamos sobre el botón , situado en la barra de 
herramientas y seleccionamos el tipo de ensamblado (archivo ejecutable o DLL). 

 

Una vez cargado el proyecto, disponemos de tres métodos para analizar el ensamblado: 

• Haciendo clic en el botón Analizar de la barra de herramientas. 

• Desde el menú proyecto, seleccionando Analizar. 

• Presionando la tecla F5. 

Cuando comienza el análisis, aparece el cuadro de diálogo “Analyzing with engine”, mostrando 
una barra de progreso y un botón de cancelar. La etiqueta del cuadro de diálogo incluye el nombre del 
motor de análisis en uso. Cuando se completa el análisis, se muestra un informe en el panel de 
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mensajes. Si no hay mensajes, el panel estará vacío. 

 

Es posible cancelar el análisis de un proyecto en cualquier momento. Tan sólo tenemos que 
pulsar el botón Cancelar del cuadro de diálogo del análisis. Al realizar esta acción, aparecerá una 
ventana con un resumen de las estadísticas del análisis y los mensajes de error. Un mensaje está 
siempre en uno de los siguientes estados: activo, excluido o ausente. Cuando comienza un análisis, 
todos los mensajes en estado Activo se cambian al estado Ausente. 

3.2.2. Resumen de los resultados de un análisis.  

Durante un análisis, FxCop reúne estadísticas y captura excepciones lanzadas por las reglas. Las 
excepciones de las reglas no detienen el análisis, a menos que el número total de excepciones exceda 
del límite especificado para el proyecto. Este límite se puede modificar en el menú Tools -> settings... -> 
Project Defaults. 

Si un análisis genera errores, se muestra un cuadro de diálogo con un resumen del análisis, una 
vez completado éste. En el caso de que no se haya generado ningún error, se puede ver este resumen 
del análisis desde el menú proyecto -> Analysis Summary. 

 

El informe muestra el número de mensajes generados, la hora de comienzo del análisis y la 
duración de éste. El resumen del informe también indica cualquier problema que haya encontrado la 
aplicación mientras se lleva a cabo el análisis. 
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3.3 Gestión de proyectos FxCop 

3.3.1. Creación de un Nuevo proyecto.  

Cuando se crea un nuevo proyecto, la aplicación realiza las siguientes acciones: 

• Cierra el proyecto actual si hay alguno abierto. 

• Resetea todas las opciones del proyecto a sus valores por defecto. 

• Carga todas las librerías de reglas encontradas en el directorio de reglas especificado en los 
ajustes de la aplicación. El directorio por defecto es el subdirectorio de reglas, por debajo del 
directorio de instalación de la aplicación (donde se encuentra FxCop.exe). Por defecto, el 
directorio de instalación de FxCop es C:\Archivos de programa\Microsoft FxCop 1.35. Por lo 
tanto el directorio donde se encuentran las reglas que se van a añadir al nuevo proyecto se 
encuentran en la ruta C:\Archivos de programa\Microsoft FxCop 1.35\Rules. 

Para crear un nuevo proyecto, seleccionamos el menú File -> New Project, pulsamos Ctrl+N o 

hacemos clic en el icono . 

3.3.2. Abrir proyectos existentes.  

La manera más simple para abrir un proyecto con FxCop es hacer doble clic en un archivo de 
proyecto de FxCop. Esto ejecuta la aplicación y carga el proyecto. Otra alternativa para abrir un proyecto 

existente es elegir en el menú File -> Open Project o hacer clic en el icono . 

 
* Archivo .FxCop 
 

Cabe destacar que la aplicación carga únicamente aquellos objetos guardados expresamente 
para el proyecto que abrimos. A diferencia de cuando abrimos un nuevo proyecto, el abrir un proyecto 
existente no implica que se carguen las librerías de reglas por defecto. 

3.3.3. Errores de carga del proyecto.  

Si un proyecto no se puede cargar completamente, se muestra un cuadro de diálogo del error. 
Los siguientes errores hacen que no se cargue completamente un proyecto: 
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• El archivo del proyecto está corrupto. 

• Una regla especificada en el archivo del proyecto está corrupta o no se encuentra. 

• Un objetivo especificado en el archivo del proyecto está corrupto o no se encuentra y tiene 
una entrada en el informe del proyecto de un análisis previo. 

• El número de versión del archivo del proyecto es mayor que el número de versión de FxCop. 

En el caso de que se cargue un proyecto pero no se han añadido todos los objetivos o no se han 
importado todos los mensajes, aparecerá el cuadro de diálogo Error(s) Loading Project. 

 

Si hacemos doble clic en el mensaje “Could not import all messages” , aparecerá el cuadro de 
diálogo de las advertencias que muestra en modo de vista de árbol los mensajes no importados. 

 

3.3.4. Abrir proyectos existentes.  

Para mantener los ajustes actuales del proyecto, éste debe ser guardado antes de salir de la 
aplicación o de abrir un proyecto diferente. Para guardar un nuevo proyecto, seleccionamos el menú File 

-> Save Project o Save Project As..., presionamos las teclas Ctrl+S o pulsamos sobre el icono . Si el 
proyecto ya se había guardado anteriormente, la aplicación sobrescribe la versión anterior. 

3.3.5. Importar mensajes a un proyecto.  

Se pueden importar múltiples informes de un análisis guardado anteriormente. Los contenidos de 
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un informe son tratados como una extensión de los contenidos del proyecto. Cuando se aplica un 
mensaje importado a un objetivo del proyecto, este mensaje se añade al proyecto. Para importar los 
mensajes a un informe guardado, seleccionamos en el menú File -> Import Report. 

Como ya se ha visto anteriormente, un mensaje se puede encontrar en los siguientes estados: 
Activo, Excluido o Ausente. Si aparece el mismo mensaje en múltiples fuentes y en cada una de ellas 
tiene un estado diferente, la aplicación hace lo siguiente: 

• Si un mensaje está en estado Excluido en cualquier entrada, el mensaje estará Excluido en 
el proyecto. 

• Si un mensaje está en estado Activo en cualquier entrada, y no está Excluido en ninguna de 
las entradas, el mensaje será Activo en el proyecto. 

• Si un mensaje no está en estado Activo ni Excluido en ninguna entrada, y está Ausente en 
alguna entrada, el mensaje será Ausente en el proyecto. 

3.3.6. Importar errores.  

Si ocurre un error mientras se importa un informe debido a un archivo corrupto que no está bien 
construido en el documento XML, se mostrará un cuadro de diálogo del error, con la descripción de éste 
y el número de línea. 

Se puede importar un informe pero no todos los mensajes mapeados (cada mensaje está 
asociado con un objetivo específico y una regla específica) por las siguientes razones: 

• Un objetivo o regla específica no existe en el proyecto. 

• Un objetivo o regla específica está deshabilitado en el proyecto. 

Si no hay mapeados ningún mensaje, aparecerá un mensaje de advertencia que preguntará si 
queremos información adicional sobre los mensajes no importados. 

3.3.7. Ajustes de las opciones del proyecto.  

Usaremos las opciones del proyecto para habilitar o deshabilitar las características de FxCop 
para el proyecto actual. En el menú Tools -> Settings..., estableceremos las opciones por defecto para el 
nuevo proyecto. 

Para editar las opciones del proyecto actual, seleccionaremos el menú Project -> Options..., y se 
mostrará una pantalla donde podremos modificar estas opciones. 

• Pestaña Standard  
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 Project Name: Esta opción nos permite dar un nombre al proyecto. Este nombre 
aparecerá en la ventana de la aplicación y se salva junto a los ajustes del proyecto. 

 Report Style Sheet y Apply Style Sheet: Cuando se guarda un informe, la hoja de 
estilos URI especificada por Report Style Sheet es incluida en el XML como una 
instrucción de proceso de hoja de estilos XML. Los navegadores que reconocen la 
instrucción mostrarán el XML usando la hoja de estilos. Por defecto, se especifica el 
FxCopReport.xls enviado con FxCop. Para omitir la instrucción de proceso, el Report 
Style Sheet se deja en blanco. Para aplicar la hoja de estilos al informe y guardar el 
resultado transformado, se selecciona la opción Apply Style Sheet. 

 Shared Project: Esta opción permite que un proyecto sea compartido por múltiples 
entornos con configuraciones que son idénticas a excepción de los directorios de 
instalación. Cuando se selecciona esta opción, los archivos del proyecto se guardan 
en rutas relativas. Si no está seleccionada, se guardarán en rutas absolutas. En un 
proyecto compartido, todos los objetos (ensamblados, reglas y mensajes excluidos) 
deben residir en una de las siguientes ubicaciones: 

 En el mismo directorio que el proyecto. 

 En el directorio donde se encuentra instalado FxCop. 

 En un subdirectorio del directorio de instalación de FxCop. 

 En una UNC compartida. 

Por ejemplo, si se guarda un proyecto en ‘C:\Mis Documentos\Proyectos\Proyecto1’, 
los objetos del proyecto pueden ubicarse en cualquier directorio de la unidad C:, 
dentro del directorio de instalación de FxCop o en un subdirectorio dentro de éste. No 
es necesario que el proyecto se encuentre en el mismo directorio que el directorio de 
instalación de FxCop. 

La opción de Shared Project está deshabilitada cuando creamos nuevos proyectos. 
Si se habilita esta opción y el proyecto contiene objetos que no se encuentran en 
ubicaciones válidas, no se podrá salvar el proyecto hasta que esos objetos sean 
eliminados. 

 Attempt source file lookup: Esta opción determina si FxCop intenta buscar la 
ubicación del código fuente del elemento de programación cuando se genera un 
mensaje. Deshabilitando esta opción se incrementa el rendimiento. 

 Save Messages: Estos ajustes permiten especificar qué mensajes se guardan en el 
proyecto y en los informes generados por el proyecto. Cuando se inicia FxCopCmd, 
el resultado está basado en los ajustes del informe del proyecto. Si estos ajustes no 
están configurados para salvar los mensajes en el informe, el resultado de 
FxCopCmd no contendrá ningún mensaje, incluso si estos se han generado. 

Se pueden salvar mensajes con cualquier combinación de los siguientes estados: 

 Activo: mensajes que se han generado durante los análisis más recientes. 
Se pueden salvar todos los mensajes activos o sólo aquellos mensajes que 
han aparecido primero durante los análisis más recientes, eligiendo de la 
lista All Active o New Only, respectivamente. 

 Excluido: Mensajes que han sido marcados en el proyecto actual o 
importados de un informe. 

 Ausente: Mensajes que han sido generados en un análisis previo, pero no 
generados en los análisis más recientes. 
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 Suspend analysis after y Disable rules after:  Estos ajustes especifican un límite en el 
número de excepciones encontradas antes de que se deshabilite una regla o se 
cancele el análisis. Las reglas deshabilitadas se excluyen del análisis restante. El 
límite por defecto son 10 excepciones. 

El límite por defecto para cancelar un análisis son 100 excepciones. Para que no 
haya un número límite de excepciones, se puede dejar en blanco la caja de texto o 
asignar el valor –1. 

• Pestaña  Saving & compression:  

 

 

 Project Save: Este ajuste determina si FxCop minimiza el tiempo que toma para 
salvar un proyecto o minimiza la diferencia entre los proyectos guardados después 
de análisis repetidos. Para minimizar las diferencias de archivo, la opción “Minimize 
file differences between saves” debe estar activada durante el guardado de archivos. 

 Save Rules By: Este ajuste determina qué grupo de categorías de reglas se guardan 
en el proyecto y, en consecuencia, cómo deben aparecer la próxima vez que se 
carga el proyecto. 

 Compress Project File: Este ajuste permite especificar si se comprime el proyecto 
cuando éste es guardado. Para comprimir un proyecto, FxCop guarda la información 
de las jerarquías de los objetivos y las reglas. Por ejemplo, cuando se seleccionan 
todos los nodos pertenecientes a un nodo padre o no se selecciona ninguno de los 
nodos hijos, FxCop guarda únicamente el nodo padre y el estado chequeado. 
Cuando se abre el proyecto comprimido, FxCop chequea todos los nodos hijos. 

FxCop comprime el proyecto para minimizar el tamaño. Sin embargo, comprimir un 
archivo dificulta la detección de nuevas reglas que se hayan añadido a las librerías, 
así como los objetivos que son cargados para el análisis. Por defecto, FxCop 
establece el estado de nuevas reglas y objetivos de acuerdo con el estado del nodo 
primario del proyecto. 
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• Pestaña spelling & analysis:  

 

 Dictionary Locale: Este ajuste determina el lenguaje utilizado para las reglas 
ortográficas. Se debe instalar el Microsoft Office Proofing Tools (chequeo ortográfico) 
para el lenguaje especificado. 

 Control Flow analysis: Para habilitar esta opción, seleccionamos True en el cuadro 
de diálogo desplegable. Para deshabilitarlo, seleccionamos False. Cuando se 
selecciona Use default engine setting, el Control Flow Analysis depende del ajuste 
Enable Control Flow Analysis, que está a True por defecto. 

 Run all overridable rules against all targets: La mayoría de las reglas de FxCop, 
chequean sólo objetivos que son externamente visibles, es decir, un objetivo que 
puede ser accesible desde fuera de su ensamblado (En C#, se refiere a los tipos y 
miembros que tienen accesibilidad pública, protegida o interna protegida). 

Cuando se activa esta opción, estas reglas chequean objetivos de todas las 
visibilidades. 

3.3.8. Estableciendo preferencias y valores por def ecto del proyecto:  

Para editar los ajustes de la aplicación seleccionamos el menú Tools -> Settings. Los ajustes se 
dividen en cuatro categorías: 

• Preferentes 

• Fonts & Colors 

• Análisis Engines 

• Project Defaults 
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• Pestaña Preferencias:  

 

 

 Check for updates to FxCop on startup: Cuando se habilita esta opción, FxCop busca 
si hay una versión actualizada de la aplicación. El resultado de esta búsqueda se 
muestra en el panel de propiedades. Únicamente se transmite el número de versión. 
No se descarga ningún archivo. 

 Filtering messages when selecting targets or rules:  Este ajuste habilita o deshabilita 
el filtro de los mensajes. 

 Source Code Editor: Si la información de la Base de Datos programada (PDB) está 
disponible para un análisis de un ensamblado, FxCop puede ubicar y abrir el código 
fuente usado para construir dicho ensamblado. Esta característica es accesible 
desde la pestaña de propiedades del panel de propiedades cuando se selecciona el 
mensaje. 

Por defecto, FxCop tiende a abrir el código fuente del archivo usando Microsoft 
Visual Studio .Net. Para usar un editor de código diferente, hay que seleccionar la 
opción “Launch in an alternate application”. Se pueden usar variables de entorno 
cuando se especifica este ajuste. En el cuadro de argumentos hay que especificar 
los argumentos que van a ser pasados al programa. 
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• Pestaña Fonts & Colors:  

 

Por defecto, FxCop tiende a abrir el código fuente del archivo usando Microsoft Visual Studio 
.Net. Para usar un editor de código diferente, hay que seleccionar la opción “Launch in an 
alternate application”. Se pueden usar variables de entorno cuando se especifica este ajuste. En 
el cuadro de argumentos hay que especificar los argumentos que van a ser pasados al programa. 

Para cambiar la fuente usada en el panel de configuración, hacemos clic en Tree, en la sección 
Fonts. Para cambiar la fuente usada en el panel de mensajes, hacemos clic en List, en la sección 
Fonts. Para cambiar la fuente usada en el panel de propiedades hacemos clic en Output, en la 
sección Fonts. 

Además de ajustar la fuente usada para mostrar los mensajes, se puede asignar un color a cada 
nivel de mensaje. Para cambiar el color por defecto, seleccionamos el nivel del mensaje de la 
lista desplegable y hacemos clic en MessageLevel. Seleccionamos el color a establecer para el 
mensaje. 
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• Pestaña Analysis Engines:  

 

La versión actual de FxCop utiliza únicamente el motor de introspección. Si esta opción no está 
seleccionada no se podrá realizar el análisis. Para habilitar la información del motor y el botón de 
ajustes seleccionamos la etiqueta de introspección. La información del motor proporciona una 
breve descripción de éste y lista los tipos de archivos que puede cargar. 

El botón de ajustes muestra un cuadro de diálogo, que contiene lo siguiente: 

 Number of Analysis Threads: Por defecto, el número de hilos del análisis está 
configurado dependiendo del número de procesadores del ordenador que realiza el 
análisis. Para eliminar cualquier posibilidad de caer en un punto muerto, que evitaría 
completar el análisis, el número de hilos debe ser 1. De todas formas, esto 
incrementaría el tiempo del análisis. 

 Enable Control Flow Analysis: El análisis del flujo de control es una técnica que 
permite construir todas las posibles rutas de código y las posibles manipulaciones de 
objetos. Este tipo de análisis es capaz de procesar un conjunto de problemas 
diferente a los de las técnicas estáticas de análisis, pero ralentiza considerablemente 
el tiempo de análisis. 

Si se deshabilita esta opción, se evita que se ejecuten por defecto algunas reglas de 
FxCop. Cuando se lleva a cabo un análisis con esta opción deshabilitada, se muestra 
un mensaje en la pestaña de resultado del panel de propiedades. Este mensaje no 
se borra si se habilita esta opción y se lleva a cabo otro análisis. 
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• Pestaña Project Defaults:  

 

 Rules Directory: Todas las librerías de reglas que se encuentren en este directorio se 
cargarán al crear un nuevo proyecto. Se pueden usar variables de entorno cuando se 
especifica este ajuste. Los siguientes ajustes son similares a los explicados 
anteriormente en la pestaña standard de las opciones del proyecto, excepto que 
éstos se aplican al nuevo proyecto, no al proyecto actual. 

 Report StyleSheet. 

 Shared Project. 

 Apply StyleSheet. 

 Attempt source file lookup. 

 Do not fire messages against legacy code for which the fix is a breaking 
change. 

 Save Messages. 

 Compress project file. 

 Suspend analysis after. 

 Disable rules after. 
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• Pestaña Project Defaults (cont.):  

 

 Spelling Options: Este ajuste determina qué lenguaje se usa para las reglas 
ortográficas. Debe estar instalado el Microsoft Office Proofing Tools. 
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3.4 Gestión de ensamblado de objetivos 

 

En esta sección se explica cómo se añade, ignora y elimina objetivos en un proyecto, cómo se especifica 
la ubicación de un objetivo usando variables de entorno y se revisará el objetivo MSIL. 

3.4.1. Añadir Ensamblados de objetivos:  

En primer lugar, hay que tener en cuenta que para realizar un análisis se deben especificar uno o 
más ensamblados. Abrimos un proyecto nuevo o existente y añadimos los ensamblados (archivos .exe o 
.dll) mediante los siguientes procedimientos: 

• Arrastrar un ensamblado al proyecto actual. Hacemos clic en la pestaña Targets del panel de 
configuración y desde el Windows Explorer arrastramos los archivos dentro del panel de 
configuración. 

• Añadir un ensamblado al proyecto actual. Desde el menú Project, seleccionamos Add 
Targets. Buscamos el objetivo a añadir y hacemos clic en el botón Open. 

FxCop añade el ensamblado al proyecto actual con todos sus tipos y miembros habilitados. Si no 
se quieren añadir estos al proyecto, hay que deshabilitarlos. 

3.4.2. Errores en la carga de objetivos:  

Si ocurre algún error durante la carga, aparecerá el cuadro de diálogo de errores, listando los 
ensamblados que no se han podido cargar y las razones. Haciendo doble clic en un objeto de la lista 
aparecerá el cuadro de diálogo AssemblyLoadException que proporciona, si está disponible, la siguiente 
información: 
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3.4.3. Ensamblados Delay-Signed:  

Cuando intentamos añadir un ensamblado Delay-Signed, FxCop reporta el siguiente error: 

Strong name validation failed for assembly 'SomeAssemblyName' 

El .Net Framework no puede verificar la firma de un ensamblado delay-signed, por lo que lo 
considera inseguro para cargarlo. Este ensamblado no se cargará a menos que se deshabilite la 
verificación de firma usando la herramiento Strong Name (Sn.exe) que se encuentra con el .Net 
Framework. Para deshabilitar la verificación del ensamblado escribimos la siguiente línea de 
comandos:El .Net Framework no puede verificar la firma de un ensamblado delay-signed, por lo que lo 
considera inseguro para cargarlo. Este ensamblado no se cargará a menos que se deshabilite la 
verificación de firma usando la herramiento Strong Name (Sn.exe) que se encuentra con el .Net 
Framework. Para deshabilitar la verificación del ensamblado escribimos la siguiente línea de comandos: 

SN -Vr SomeAssemblyName 

Esto permite que el ensamblado SomeAssemblyName se salte la verificación. Después de que un 
ensamblado se haya registrado de esta manera, la aplicación no intentará verificar la firma. Las 
instancias de FxCop no detectarán el nuevo registro. Entonces, salimos de la aplicación y cargamos de 
nuevo el ensamblado. 

Hay que tener en cuenta que si deshabilitamos la verificación de un ensamblado crea 
vulneraciones de la seguridad. Para rehabilitar la verificación, escribimos lo siguiente: 

SN -Vu SomeAssemblyName 

3.4.4. Ignorar objetivos durante el análisis:  

Para ignorar un ensamblado, un tipo o un miembro durante el análisis deseleccionamos el 
checkbox que se encuentra junto al nombre del objetivo. Esto también elimina la selección de todos los 
nodos hijos. Un objetivo ignorado permanece en la pestaña Targets del panel de configuración y los 
mensajes relevantes se mantienen en el panel de mensajes y son escritos en informes guardados. En 
análisis posteriores, los objetivos que no están seleccionados son ignorados, por lo que no producen 
ningún mensaje.  

Hay que tener en cuenta que los cambios realizados a un objetivo no se guardan hasta que se 
haya guardado el proyecto. 

3.4.5. Eliminar ensamblados de un proyecto:  

Como se ha explicado en el punto anterior, se puede ignorar un ensamblado, un tipo o un 
miembro de un proyecto. De la misma manera, se puede eliminar completamente un ensamblado de un 
proyecto. Si eliminamos un ensamblado, debemos añadirlo posteriormente al proyecto para poder 
incluirlo en un análisis. Asimismo, los informes generados por ese ensamblado también se eliminarán. 

Para eliminar un ensamblado del proyecto actual hacemos clic en la pestaña Targets del panel de 
configuración. Seleccionamos el ensamblado que queremos eliminar y desde el menú Edit elegimos 
Remove File. También podemos eliminarlo haciendo clic en el botón derecho del ratón y eligiendo la 
opción Remove. 
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3.4.6. Especificar una ubicación para un ensamblado  utilizando variables de entorno:  

Se puede especificar la ubicación de donde se carga un ensamblado usando una ruta que incluya 
variables de entorno. FxCop lee las variables de entorno cuando se inicia la aplicación. Cualquier 
cambio que se realice en las variables de entorno se ignora hasta que FxCop se reinicie de nuevo. 

Para especificar una ubicación usando variables de entorno, hacemos clic en la pestaña Targets 
del panel de configuración y clic con el botón derecho encima del nombre del ensamblado. 
Seleccionamos Properties y escribimos la ubicación en el cuadro de texto Save Name. 

Cabe destacar que si usamos variables de entorno para la ubicación de un ensamblado puede 
fallar la carga de éste si las variables de entorno no están inicializadas. Esto puede requerir que se 
tenga que editar el archivo del proyecto para corregirlo. Como una alternativa a las variables de entorno 
se puede utilizar la opción de proyecto compartido (Shared Project). 

3.4.7. Ver Metadata y MSIL:  

Se puede visualizar Metadata y Microsoft Intermediate Language (MSIL) en aquellos proyectos 
cargados en FxCop. Para ver Metadata hacemos clic en la pestaña Targets del panel de configuración. 
Expandimos el ensamblado y los subnodos. Seleccionamos el elemento del que queremos ver el 
Metadata y éste aparece en el panel de propiedades. Hacemos clic con el botón derecho del ratón en el 
elemento, elegimos View y seleccionamos IL. Aparecerá una ventana mostrando el MSIL. 
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3.5 Gestión de reglas 

 

Las reglas determinan los aspectos que FxCop busca durante un análisis. FxCop incluye un conjunto de 
librerías de reglas por defecto. Cada regla está asignada a un nivel que indica la importancia de un aspecto 
detectado por la regla y una certeza que estima la probabilidad de que un aspecto sea detectado correctamente. 

3.5.1. Librerías de reglas por defecto:  

FxCop incluye las siguientes librerías, basadas en las guías de diseño de .Net Framework, 
cargadas por defecto cuando se crea un nuevo proyecto: 

• COM: reglas que detectan temas COM Interop. 

• Desing : detectan defectos potenciales de diseño. Estos errores no se reflejan en la ejecución 
del código. 

• Globalization : detectan un uso incorrecto o perdido de la información relacionada con la 
globalización y la localización. 

• Naming : detectan casos incorrectos, colisiones de lenguaje cruzado y otros aspectos 
relacionados con los nombres de los tipos, miembros, parámetros y ensamblados. 

• Performance : detectan elementos en los ensamblados que degradan el rendimiento. 

• Security : detectan elementos de programación que dejan los ensamblados vulnerables a 
código y usuarios maliciosos. 

• Usage : detectan defectos potenciales en los ensamblados que pueden reflejarse en la 
ejecución del código. 

Es posible visualizar las librerías cargadas actualmente desde la pestaña Rules del panel de 
configuración. Para visualizar las reglas que contiene una librería hacemos doble clic en el nombre de 
ésta y para visualizar la información detallada de una regla hacemos doble clic en el nombre de la regla. 

Por defecto, se copiará la librería s72b_FxCopEjieRulesLib.dll en Rules y en la pestaña Rules de 
la aplicación se seleccionará sólo la de EJIE. De todas formas, si se desean utilizar otras reglas, se 
puede hacer tal y como se indica a continuación.  

3.5.2. Añadir reglas a un proyecto:  

Para establecer el alcance de un análisis, se deben incluir en el proyecto una o más librerías. 
Para los proyectos nuevos, se cargan automáticamente todas aquellas librerías ubicadas en el directorio 
de las reglas. Para proyectos existentes, los ajustes para las librerías se guardan como parte del 
proyecto y se cargan junto a otros objetos del proyecto. Cuando se abre un proyecto existente, 
únicamente se cargan las reglas guardadas previamente. Las librerías del directorio de reglas 
especificado en los ajustes de la aplicación no se cargan automáticamente. 

Para arrastrar una librería al proyecto actual, hacemos clic en la pestaña Rules del panel de 
configuración y desde el Windows Explorer arrastramos los archivos a añadir dentro del panel de 
configuración. 

Para añadir una librería al proyecto actual, seleccionamos el menú Project -> Add Rules. 
Buscamos la librería a añadir y pulsamos Open. 
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3.5.3. Agrupar reglas:  

Las reglas pueden ser agrupadas por nombre de archivo, nivel del mensaje o versión. Esto 
permite filtrar los mensajes mediante estas agrupaciones y habilitar o deshabilitar las reglas de un grupo 
específico. Por defecto, las reglas se agrupan por el nombre de archivo del ensamblado que contiene la 
regla. Breaking Change significa que un ensamblado que tiene dependencia de una versión de una 
librería no funcionará con una nueva versión de ésta. 

Para cambiar la agrupación de las reglas hacemos clic con el botón derecho del ratón en una 
regla o grupo de reglas en el panel Rules. Seleccionamos Group By y elegimos una de las agrupaciones 
del menú. 

3.5.4. Ignorar reglas durante un análisis:  

Se puede ignorar una regla o una librería entera durante un análisis. Los objetos ignorados se 
mantienen en el panel de configuración pero no son usados en análisis posteriores de código. 

Para excluir una regla o una librería de un análisis hacemos clic en la pestaña Rules. Si se quiere 
ignorar una única regla, expandimos la librería que la contiene y deseleccionamos el checkbox 
perteneciente a la regla. 

3.5.5. Eliminar librerías de un proyecto:  

Cuando se elimina una librería del proyecto actual, ésta no aparece en el panel de configuración y 
hay que añadirla de nuevo al proyecto para que todas sus reglas puedan incluirse en un análisis. De la 
misma manera, todos los mensajes generados por la regla eliminada son también eliminados del 
proyecto. 

Para eliminar una librería del proyecto actual hacemos clic en la pestaña Rules y seleccionamos 
la librería. Desde el menú Edit elegimos Remove File. También se puede seleccionar la librería y 
presionar ENTER o hacer clic con el botón derecho del ratón y elegir Remove. 

3.5.6. Ver detalles de las reglas:  

Se puede acceder a las librerías de reglas cargadas actualmente desde la pestaña Rules del 
panel de configuración. Para ver la información detallada de una regla, hacemos doble clic en ella. 
Alternativamente, podemos hacer clic con el botón derecho y seleccionar propiedades en el menú 
contextual. 
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La siguiente tabla describe la información almacenada en una regla y mostrada en el cuadro de 
diálogo del detalle: 
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• Nivel y Seguridad:  

Cada regla es asignada a un nivel que indica la importancia del aspecto detectado por la regla y 
la seguridad que estima la probabilidad de que un objeto sea detectado correctamente. 

Tres factores determinan el nivel asignado a una regla: 

 La visibilidad del objeto detectado. 

 La probabilidad de que el objeto detectado tenga un impacto negativo en la 
aplicación de su comportamiento. 

 El riesgo asociado al arreglo del objeto. 

 

 

 

Las reglas tienen asignadas 5 niveles de importancia: 

 Error Crítico: Este nivel refleja los objetos que son altamente visibles. Los mensajes 
de error crítico son los primeros que se resuelven y deberían excluirse únicamente 
después de evaluar cuidadosamente el impacto de ignorar el error. 

 Error: Los aspectos reportados en este nivel tienen menos impacto en utilidad y 
comportamiento que los errores críticos, pero no deberían excluirse sin una 
evaluación cuidadosa. 

 Advertencia crítica: Este nivel refleja los aspectos que generalmente tienen poco 
impacto en el comportamiento del código. Concierne al mantenimiento del código. 
Por otra parte, en una minoría de los casos, estos mensajes son considerados 
errores y, por lo tanto, deberían revisarse cuidadosamente antes de que sean 
excluidos. 

 Advertencia: Los mensajes en este nivel se refieren generalmente a mantener el 
código fuente estable, extensible y sostenible. 

 Informativa: Los mensajes en este nivel son devueltos por reglas que devuelven 
información sobre un objetivo, pero no detectan errores. 

La columna que contiene el nombre del nivel en el panel de mensajes indica el nivel 
de la regla que genera el mensaje. La columna del nivel proporciona una visión 
icónica de la misma información. 

La seguridad estima la probabilidad de que un aspecto sea detectado correctamente. 
Se expresa en porcentaje. Un valor alto indica la confianza de que una regla detecte 
un aspecto real. Si el factor de seguridad es bajo, reflejará un falso positivo. 

No es aconsejable ignorar los mensajes basados en nivel o en seguridad. Se deben 
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revisar todos los mensajes para determinar si alguno devuelve un aspecto actual y, 
por lo tanto, evaluar los riesgos que supone ignorar el error. 

3.5.7. Especificar una ubicación para una regla usa ndo variables de entorno:  

Se puede especificar la ubicación de una regla que se carga en un ensamblado, usando una ruta 
que incluye variables de entorno. FxCop lee estas variables cuando se ejecuta la aplicación. Cualquier 
cambio que se produzca en estas variables de entorno es ignorado hasta que se reinicie FxCop. Las 
reglas se deben ordenar por nombre de archivo para que esta opción esté disponible. 

Para especificar la ubicación usando variables de entorno hacemos clic en la pestaña Rules del 
panel de configuración. Con el botón derecho del ratón encima de la regla abrimos el menú contextual y 
elegimos Properties. Escribimos la nueva ubicación en el cuadro Save Name. 

Cabe destacar que el uso de variables de entorno para una ubicación de una regla puede 
producir un fallo en la carga del ensamblado si las variables de entorno no están inicializadas. Esto 
requiere una edición manual del archivo del proyecto para corregirlo. Una alternativa a las variables de 
entorno puede ser el proyecto compartido (Shared Project). 
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3.6 Gestión de mensajes 

 

Los mensajes son generados por reglas cuando éstas analizan un objetivo. Cada mensaje está vinculado 
a una regla específica y a un objetivo específico y puede reportar múltiples ocurrencias de la violación de una 
regla. 

Para generar mensajes, después de especificar un conjunto de ensamblados y reglas, ejecutamos el 
análisis usando uno de los siguientes métodos: 

• Haciendo clic en el botón Analyze de la barra de herramientas. 

• Presionando la tecla F5. 

• Desde el menú Project, seleccionando Analyze. 

El panel de mensajes muestra los mensajes generados por el análisis. El color del texto indica el nivel del 
mensaje. 

 

 

 

Para visualizar los mensajes Activos, Excluidos o Ausentes del proyecto podemos presionar los botones 
situados encima del panel. También podemos ordenarlos haciendo clic en el encabezado de columna deseado. 

Si hacemos clic con el botón derecho, visualizaremos las acciones disponibles para un mensaje que, 
dependiendo del estado del mensaje, incluyen: 

• Cambio en el estado del mensaje. 

• Añadir una nota a un mensaje. 

• Mostrar detalles sobre el mensaje. 

• Personalizar el conjunto de columnas mostradas en el panel de mensajes. 

• Ordenar los mensajes. 

• Copiar al portapapeles el mensaje seleccionado. 
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Es posible copiar uno o más mensajes al portapapeles en formato CSV (comma-separated value) o XML. 
La información copiada contiene las mismas columnas que aquellas mostradas en el panel de mensajes y es un 
subconjunto de la información guardada en el proyecto. 

Para copiar mensajes seleccionamos aquellos que queremos copiar. Con el botón derecho abrimos el 
menú contextual, seleccionamos Copy As y, por último, seleccionamos el formato, CSV o XML. 

3.6.1. Estado de los mensajes:  

Hay que tener en cuenta que el estado de los mensajes puede cambiar. La siguiente tabla 
identifica los posibles estados de un mensaje. Los estados Activo, Excluido del proyecto y Ausente son 
exclusivos y se pueden visualizar utilizando los botones correspondientes, situados encima del panel de 
mensajes. El nuevo estado se puede combinar con cualquiera de los otros estados. Cabe destacar que 
los mensajes que se encuentran en el nuevo estado aparecerán en negrita. 

Hay que tener en cuenta que el objetivo asociado a un mensaje excluido no es chequeado por la 
regla asociada a este mensaje durante la ejecución del análisis. 

 

3.6.2. Configurar columnas:  

Es posible configurar qué columnas se muestran y en qué orden, dentro de la lista de mensajes, 
así como establecer la anchura de cada columna. 

Para configurar las columnas hacemos clic con el botón derecho y seleccionamos Configure 
Columns del menú contextual. Seleccionamos el nombre de la columna que queremos mostrar y 
hacemos clic en su checkbox correspondiente. Asimismo, se habilitará un cuadro de texto donde se 
podrá especificar el ancho de la columna. Usando los botones Move Up y Move Down podemos cambiar 
el orden de las columnas. 
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La siguiente tabla describe cada columna: 
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3.6.3. Filtrar mensajes:  

Este método permite ver un subconjunto de mensajes presente en el panel de mensajes. 
Después de llevar a cabo un análisis, se pueden filtrar los mensajes mostrados haciendo clic en los 
objetos del panel de configuración: 

• Seleccionar una categoría de regla para mostrar únicamente los mensajes generados por las 
reglas pertenecientes a esa categoría. 

• Seleccionar una regla específica para mostrar sólo los mensajes generados por dicha regla. 

• Seleccionar un objetivo para mostrar sólo los mensajes de ese objetivo y de sus nodos hijos. 

Para eliminar el filtro actual y ver todos los mensajes, hacemos clic en el nodo principal del 
proyecto en la pestaña Targets o Rules. Cuando el filtro está deshabilitado, se muestran todos los 
mensajes aunque haya alguna selección en el panel de configuración. 

3.6.4. Ver los detalles de los mensajes:  

Cuando seleccionamos un mensaje y presionamos la tecla ENTER, hacemos clic con el botón 
derecho y seleccionamos Propiedades o hacemos doble clic en un mensaje, se muestra la información 
sobre el mensaje y las reglas que lo generan. Los botones Previous y Next nos permiten navegar a 
través de la lista de mensajes. Cuando se muestra un mensaje Activo o Excluido, se habilita el botón 
Exclude o Unexclude, según corresponda, lo que nos permite alternar entre los dos estados. 

 

*Detalles del mensaje en la pestaña Issues 



  
 
 
 

 

 
 

FxCop. Manual de usuario 32/44 

 
 

 

*Detalles del mensaje en la pestaña Message 

 

La siguiente tabla describe la información disponible en las pestañas Issues y Message. La 
pestaña Rule Support y Rule Details muestran información sobre la regla que genera el mensaje. 
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El objeto Source muestra uno de los siguientes valores: 

• Source File y Line Number Information: Hacer clic en el link para abrir el código fuente en 
el editor. 

• <Source Lookup Disabled>: El archivo fuente está deshabilitado. 

• <Location not stored in Pdb>: El archivo PDB para el ensamblado no está disponible o la 
información fuente no está disponible para el elemento de programación. El archivo PDB 
debe estar ubicado en el mismo directorio que su correspondiente ensamblado o en la 
ubicación que indica la variable de entorno _NT_SYMBOL_PATH. La información PDB sólo 
está disponible para métodos y propiedades. 

La pestaña Notes permite al usuario aplicar notas y asociarlas al mensaje. Las notas también se 
pueden añadir cuando el mensaje es excluido del análisis. 

Para añadir una nota a un mensaje hacemos doble clic en el mensaje y seleccionamos la pestaña 
Notes. Hacemos clic en Add para mostrar el cuadro de diálogo Edit Note. Escribimos la nota en el 
cuadro de texto y pulsamos OK. 
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3.6.5. Excluir mensajes:  

Ocasionalmente, se pueden permitir excepciones específicas para una regla sin ignorarla o 
eliminarla. Por ejemplo, se puede implementar un diseño que viola intencionadamente el .Net 
Framework para un tipo específico o FxCop puede reportar un “falso positivo”, un mensaje que no es 
preciso. 

Para eliminar un análisis por una regla específica en un objetivo, hay que excluir el mensaje 
asociado. El mensaje excluido contiene el nombre del usuario que lo ha creado y una nota opcional que 
explica la razón de esta exclusión. Este mensaje puede ser no-excluido, en cuyo caso aparecerá en la 
lista de Activo o Ausente dependiendo del valor del campo Seen Last Run. 

Para excluir mensajes hacemos clic en el botón derecho y seleccionamos Exclude en el menú 
contextual. Introducimos información relevante en el cuadro de texto y pulsamos OK. 

Para reincluir mensajes excluidos hacemos clic en el botón Excluded ubicado en la parte de 
arriba del panel de mensajes. Seleccionamos uno o más mensajes excluidos y hacemos clic en el botón 
derecho encima de la selección y elegimos Mark as Active o Mark as Absent. 

3.6.6. Guardar informes del mensaje:  

FxCop guarda los informes del mensaje en formato XML. Se puede importar a un proyecto el 
mensaje salvado y éste es tratado como una extensión de los contenidos del proyecto. 

Para guardar un informe seleccionamos del menú File la opción Save Report As. Si ningún 
mensaje coincide con los ajustes del informe, esta opción no está disponible. Seleccionamos el 
directorio donde se va a guardar el informe y en el cuadro File Name escribimos el nombre con el que 
vamos a guardarlo. Finalmente pulsamos Save. 

El esquema XML para los informes se ubica en el subdirectorio \XML instalado con FxCop. El 
nombre del archivo del esquema es FxCopReport.xsd. Si Report Stylesheet dentro del cuadro del 
diálogo de las opciones del proyecto contiene algún valor, el XML guardado contendrá una instrucción 
de proceso para la hoja de estilos especificada. Si Apply Stylesheet está seleccionado, se aplica a los 
datos del informe la hoja de estilos del informe XSL y se guarda el resultado de la transformación. 

 

4 Enlaces de referencia 

 

• Documentación:  

http://gotdotnet.com/team/fxcop/Docs/FxCopApp.html 

• FxCop:  

http://www.microsoft.com/spanish/msdn/comunidad/mtj.net/voices/art112.asp 

http://aspnet.4guysfromrolla.com/articles/060204-1.aspx 

http://www.codeproject.com/dotnet/Tool_info_report_FXCOP.asp 

 

5 Utilidad Práctica 

 
FxCop es una herramienta que permite analizar el estilo, el diseño de código de ensamblados .Net, 

llamados objetivos (targets), y genera un informe que contiene mensajes sobre estos objetivos, comprobando, 
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por ejemplo, fallos en la seguridad del código, mejoras para el rendimiento, nomenclatura de elementos y su 
localización... 

 
Por tanto será de gran utilidad para los desarrolladores durante la fase de desarrollo de las aplicaciones 

para comprobar que el código implementado está adscrito a las guías de diseño establecidas por EJIE. 
 

6 Anexo 1:  

 
El ejemplo planteado hace uso de las reglas de diseño definidas en el archivo de reglas 

“s72b_FxCopEjieRulesLib.dll” para comprobar que la implementación de la solución “NCoverCalculo” cumple con 
las recomendaciones de diseño establecidas en dichas reglas. 

 

6.1 Resolución 

 
Se seguirán los siguientes pasos para comprobar la solución “NCoverCalculo” compuesta por los 

proyectos NCoverCalculo y NCoverCalculadora (dependencia del anterior): 
 

1. En primer lugar habrá que introducir el archivo de reglas en la carpeta “rules” de la herramienta 
FxCop: 

 

 
 

2. En segundo lugar se ejecutará dicha herramienta FxCop. Accediendo a la pestaña “Rules” de la 
aplicación se podrá observar cómo el nuevo archivo de reglas considerado 
(s72b_FxCopEjieRulesLib.dll) aparece representado y, desplegando su contenido, se podrá 
obtener una descripción de las reglas contenidas en dicho archivo, como muestra la imagen 
siguiente: 
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Se podrá acceder a la descripción de cada regla considerada en dicho archivo de reglas 
seleccionándolas, nos aparecerá su información como muestra la siguiente imagen: 

 

 
 

3. Posteriormente se seleccionará este archivo de reglas como el único a utilizar para lanzar el 
análisis de nuestra solución. Para ello se deshabilitarán el resto de archivo de reglas que aparecen 
en la pestaña “Rules” 

 
4. Es el turno de seleccionar los proyectos a analizar. Para ello se hará uso de la opción de menú 

Projects >> Add targets… 
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Debemos tener en cuenta que para generar dicho análisis únicamente se pueden seleccionar 
librerías (*.dll) o ejecutables (*.exe), cualquier otro tipo de aplicación no podrá ser analizada por FxCop. 

 
Por tanto seleccionaremos los archivos “NCoverCalculo.exe” y “NCoverCalculadora.dll” (sus 

dependencias) como muestra la imagen siguiente: 
 

 
 

En las siguientes imágenes se pueden observar ambos proyectos abiertos en la pestaña “Targets”: 
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Como característica adicional tendremos la posibilidad de consultar las dependencias de ambos 

ensamblados seleccionando cada uno de ellos por separado y haciendo uso de la opción View >> Full 
Dependencias Closure obtenida a través del menú contextual: 

 

 
 

 
 

En el caso concreto del ensamblado “NCoverCalculo.exe” se puede observar como depende del 
otro ensamblado “NCoverCalculadora.dll”: 
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5. Es el momento de seleccionar el proyecto a analizar. En primer lugar elegimos el ensamblado 
“NCoverCalculadora.dll”. 

 

 
 

6. Y lanzamos el análisis haciendo uso del botón “Analyze”: 
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7. Observamos que se ha producido el siguiente resultado: 

 

 
 

Únicamente se ha encontrado una violación de las reglas consideradas. Haciendo doble clic sobre 
el error obtenido entraremos en la ventana de detalles de dicha regla y podremos observar cómo se nos 
ofrece una posible solución: 

 

 
 

Seguiremos el mismo procedimiento para realizar el análisis del ensamblado “NCoverCalculo.exe”. 
Seleccionar dicho proyecto: 
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Lanzar el análisis: 
 

 
 

Observar los resultados obtenidos: 
 

 
 

Acceder a los detalles de cada una de los errores obtenidos: 
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